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Getting Started
The SuperBar program is a Windows program for creating and editing user configurable    
tool bars called    SuperBars.    A SuperBar consists of a gray area containing several 
buttons, each assigned to an application menu command.    A SuperBar can be added to 
any Windows application that is compatible with the SuperBar program.    
The following steps demonstrate how to add a SuperBar to the Windows Program Manager.

1 Run the SuperBar program.
2 Select  Program Manager from the Application list.
3 Select SuperBar from the Application    menu to add a new SuperBar to the 

application.
4 Select SuperBar from the Application menu to add a blank SuperBar.
5 Select Edit... from the Application menu.    The SuperBar Properties dialog will be 

displayed.
6 Select the Show Bar option to cause the SuperBar to be created every time the 

application is executed.
7 Click the Layout... button.    The SuperBar Layout dialog will be displayed.
8 Select File|Exit Windows... from the Available Menu Commands list. 
9 Click the Add button.    The menu command will be placed in the Current SuperBar 

Layout list..    A stop sign    icon and 'Exit' caption will automatically be selected.
10 Click the Ok button.    The SuperBar Layout dialog will close.
11 Click the Ok button.    The SuperBar Properties dialog will close.
12 Select Program Manager from the application list.
13 Select Switch from the Application button.    This will switch to the Windows 

Program Manager.    The application will have a SuperBar along the top of the window 
with a single Exit button. 

You can now use this button to exit Windows.    To edit the SuperBar, double-click on the 
gray area to the right of the button to display the SuperBar Properties dialog.    Click the 
Help button on this dialog for further information on editing the SuperBar.



Using the SuperBar Program
The SuperBar program main window consists of an application list and several action 
buttons.    These options allow complete control over adding, removing and editing 
SuperBars. 
Application List
The application list shows all Windows applications which are currently executing.    You 
must run the desired application before it will be displayed in the application list and before
you can add or modify its SuperBar.    The list can display the icons as either text or icons.    
Use the Show as Icon or Show as Text menu commands to select the list type.
Icon Application List
The Icon Application List shows each application as its corresponding icon.    If a SuperBar is
attached to an application, its icon is shown on a button.

This illustrates the Icon Application List    and shows SuperBar and Program Manager active. 
The button under the Program Manager icon indicates it has a SuperBar attached to it.
Text Application List
The Text Application List shows each application as its Title Bar text.    If a SuperBar is 
attached to an application, a small button is shown to the left of the text.

This illustrates the Text Application List and shows SuperBar and Program Manager active.    
The button to the left of the Program Manager text indicates it has a SuperBar attached to 
it.
To edit the application's properties or SuperBar layout, select the application and use the 
Edit command from the Application menu.    
Double-clicking on an application in the list    can perform one of four actions.    The actions 
include Switch, Edit, Close and Hide.    Use the Preferences dialog box to set the desired 
double-click action.



Using a SuperBar on an Application
Once a SuperBar has been added to an application, using it is very straight forward.
Invoking a Menu Command
To invoke a menu command, simply click on the assigned button.    After the button is 
clicked, the menu command will be sent to the application.
Editing a SuperBar
To edit a SuperBar directly from its application, double-click on the gray background of the 
SuperBar.    This will open the SuperBar Properties dialog box to edit the SuperBar.



Using the Macro Feature
The Macro Feature allows assigning an arbitrary sequence of mouse and keyboard actions 
to a button.    This sequence is called a macro.    Using macros is a two-step process.    First, 
the macro must be recorded.    This includes starting a macro recording session, performing 
the desired mouse and keyboard actions, and saving the macro to a file.    Second, the 
macro must be assigned to a button.    This includes assigning a macro button to a 
SuperBar, and associating a macro file to the button.
Although the Macro Feature fully supports mouse actions, it is recommended that the 
equivalent key strokes be used as much as possible.    This includes using key strokes to 
invoke menus and navigate dialog boxes.    Using keystrokes will ensure that the macros will
perform correctly if windows are resized, or different video modes are used.
The following are step-by-step instructions to add a Landscape button to Microsoft 
Write.    The process assumes that there is already a SuperBar with at least one button 
associated with Write.    For instructions on setting up a SuperBar, see Getting Started.
Recording the Macro
1 Start Write and verify that a SuperBar is present.
2 Position the cursor anywhere over the SuperBar and click the right mouse button.    

This will bring up a pop-up menu.
3 Select the Record Macro command    (Note:    Under Windows 3.0, you must select 

this command with the left mouse button, under Windows 3.1, either button may be 
used).

4 The Record Macro dialog box is now displayed.    For this example, only key strokes 
will be used.    Choose Ignore Mouse from the Record list.

5 Click OK to begin the macro recording session.
6 Enter the following key stroke sequence:    <ALT+F> R <ALT+L> <ENTER>.    This 

will bring up the Print Setup dialog of Write and set Landscape mode.
7 Press <CTRL+BREAK> to stop the macro recording session.    This will bring up the 

Save Macro File dialog box.
8 Type LSCAPE in the File Name box and click on OK.    This will save the file as 

LSCAPE.SBM in the SuperBar directory.    The macro is now recorded.
Associating the Macro File to a Button
1 Double-click on the gray background of the SuperBar to bring up the SuperBar 

Properties dialog box.
2 Click on Layout to bring up the SuperBar Layout dialog box.
3 Select <Macro> from the Available Menu Commands list and click on Add.    This 

adds a macro button to the SuperBar.
4 Click on Browse to bring up the Select Macro File dialog box.
5 Select LSCAPE.SBM from the File Name list and click on OK.
6 Change the Icon to an appropriate icon.
7 Click on OK to close the SuperBar Layout dialog box.
8 Click on OK to close the SuperBar Properties dialog box.    The macro button is now

complete.
You can create a Portrait button by repeating the above steps changing <ALT+L> to 
<ALT+P> in step 6 of Recording the Macro and changing the file name from LSCAPE to 
PORTRAIT.    All macros are created in a similar manner using the steps listed above.



Running SuperBar when Windows Starts Up
The SuperBar program works best when it is loaded as part of Windows start up.    To 
automatically load SuperBar, perform the following steps depending on which version of 
Windows is used.
Note:    The following steps assume that Windows is located in the C:\WINDOWS    directory 
and SuperBar is located in the C:\SUPERBAR    directory.    If they are located elsewhere, 
change the steps accordingly.
Windows 3.0
To automatically load SuperBar, the Windows    WIN.INI  file must be modified.    The 
following steps show how to make this change.    

1 Run the Windows Notepad editor and open the file C:\WINDOWS\WIN.INI
2 Near the top of the file will be the following line:

Load=
If other programs are being automatically loaded, the line may be similar to the following:

Load=C:\DIR\PRG.EXE
This line consists of a list of Windows applications to be loaded each time Windows is 
started.    Each application in the list is separated by a space.

3 The SuperBar program must be added to the beginning of this line.    Change this line 
to resemble the following:

Load=C:\SUPERBAR\SUPERBAR.EXE
or

Load=C:\SUPERBAR\SUPERBAR.EXE C:\DIR\PRG.EXE
4 Exit and restart Windows.    
Windows 3.1
To automatically load SuperBar, perform the following steps:

1 Open the StartUp group in the Program Manager.
2 Select the New... command from the File menu.
3 Select Program Item and click the Ok button.
4 Enter SuperBar in the Description edit box and c:\superbar\superbar.exe in the 

Command Line edit box.    Click the Ok button.

See the Windows User's Guide for more information on using the StartUp group.
All Versions
After completing these steps, the SuperBar program will automatically be loaded each time
Windows is executed.    The SuperBar program will appear as an icon near the bottom of the
desktop    (you may need to resize the Program Manager to see this icon).    After the 
SuperBar program is loaded, any applications with the Show Bar option of the SuperBar 
Properties dialog box will display a SuperBar whenever they are executed.



Menu Commands

File Menu
Preferences...
Run Icon Manager...
Exit Windows...
Exit

Options Menu
Show as Icon
Show as Text
Status Bar
Quick Exit
Quick Windows Exit
Always on Top
Save Options

Application Menu
SuperBar
Hide
Switch to
Close
Edit
Add all
Remove all

Desktop Menu
Cascade
Tile
Arrange Icons
Minimize All
Initial Positions

Help Menu
Index
About



Preferences command (File menu)
This command opens the Preferences dialog box.    It allows selection of different options for
operating SuperBar.    It includes options for hiding the SuperBar icon and displaying 
different information in the application list.



Run Icon Manager command (File menu)
This command runs the SuperBar Icon Manager.    This program allows creating, editing 
and deleting user-defined icons.    For further help on this program, select this menu 
command to execute it and press F1 for complete on-line help.



Exit Windows command (File menu)
This command exits Windows.    If the Quick Exit Windows option in the Preferences 
dialog box is selected, Windows will immediately terminate.    If the option is not selected, a 
dialog box prompt will first be displayed.



Exit command (File menu)
This command terminates the SuperBar program.    Any active SuperBars will be removed 
from all currently executing applications.    Before exiting, close any SuperBar Properties or 
SuperBar Layout dialog boxes.



Show as Icon command (Options menu)
This command displays the available applications as icons.    The icons are the same as 
those shown when the application is minimized.



Show as Text command (Options menu)
This command displays the available applications as lines of text.    The text is the same as 
that shown in the title bar of the application.



Status Bar command (Options menu)
This command enables or disables the status bar.    The status bar is located at the bottom 
of the SuperBar window and gives status information on the currently selected application.



Quick Exit command (Options menu)
This command enables or disables the Exit SuperBar dialog box.    If the Exit command is 
selected and this option is checked, SuperBar will exit without any prompting.



Quick Windows Exit command (Options menu)
This command enables or disables the Exit Windows dialog box.    If the Exit Windows 
command is selected and this option is checked, Windows will exit without any prompting.



Always on Top command (Options menu)
This command causes SuperBar to appear on top of other windows at all times.



Save Options command (Options menu)
This command saves the current setting of this menu.    For these settings to be retained 
between SuperBar sessions, they must be saved whenever they are changed.



Show/Hide SuperBar command (Application menu)
This command shows or hides a SuperBar from the selected application.    If no SuperBar 
has been previously defined, an empty SuperBar will be created.    This menu option is only 
enabled for applications that have menus.



Show/Hide Window command (Application menu)
This command hides or restores an application's window.    A hidden application is an 
application which is running but is not displayed on the desktop.    Hiding an application 
helps to free space on the desktop.    Selecting this menu command a second time restore 
the application and displays it on the desktop again.
Note:    Hiding a window using this command is only temporary.    The window will be visible 
the next time the application is executed.    To hide an application's window every time it is 
executed, use the SuperBar Properties dialog box.



Switch To command (Application menu)
This command switches to the selected application.



Close command (Application menu)
This command closes an application.    A close window command is sent to the application 
requesting the application to terminate.    This command can be used to exit an application 
without needing to find it on the desktop.



Edit command (Application menu)
This command opens the SuperBar Properties dialog box to begin editing of the selected 
application's SuperBar.



Add All command (Application menu)
This command adds SuperBars to all applications which currently do not have a SuperBar.   
Any applications which do not have previously defined SuperBars will have empty 
SuperBars created.



Remove All command (Application menu)
This command removes SuperBars from all applications which currently have them.



Cascade command (Desktop menu)
This command rearranges all windows on the desktop so that they overlap with each title 
bar visible.



Tile command (Desktop menu)
This command rearranges all windows on the desktop to smaller sizes to fit on the desktop 
without overlapping.



Arrange Icons command (Desktop menu)
This command rearranges all icons evenly across the bottom of the desktop.    Only 
windows shrunk to icons are affected.



Minimize All command (Desktop menu)
This command shrinks all windows to icons.    Only windows with Minimize buttons are 
affected.



Initial Positions command (Desktop menu)
This command rearranges all windows to their initial positions on the desktop as defined in 
the SuperBar Properties dialog box.    Only windows with the Position option checked are 
affected.



Contents command (Help menu)
This command displays the index of the SuperBar on-line help. From the index, you can 
jump to information on General Topics, Menu Commands or Defined Terms.



About SuperBar command (Help menu)
This command displays the About dialog box.    



About Dialog
This dialog box displays information on this version of SuperBar.    It displays the version 
number of the program.    In addition, if the program is registered, a customer number will 
be displayed.    
Dialog Options

Register
Opens the Register dialog box. for entering the Registration Code.

Ok
Closes the dialog box.



Register Dialog
This dialog box is used to enter the Registration Code.    When the program is registered, 
the About SuperBar dialog box will no longer be displayed when the program is executed. 
Dialog Options

Registration Code
Enter the Registration Code in this box.

Ok
Validates the Registration Code.    If the code is valid, the dialog box will close and a 
Customer Number will be displayed on the About dialog box.    A message will be 
displayed if the code is invalid.    Close the message box to enter the Registration Code 
again.

Cancel
Closes the dialog box.    The SuperBar program will remain unregistered.



SuperBar Properties Dialog
This dialog box is used to set the properties of a SuperBar.    It allows setting the contents, 
style, location and options of the SuperBar.
Dialog Box Options

Style
Selects one of three button styles.    They include Icon Only, Caption Only and Icon with 
Caption.    The caption styles can be used to become familiar with the icons.

Bar Location
Selects the location of the SuperBar.    The SuperBar can be located along the Top, 
Bottom, Left or Right edge of the application's window.

Options
Show Bar This option causes a SuperBar to appear on the selected application 

whenever it is executed.    See also Running SuperBar when Windows 
Starts Up.

Position This option causes the selected application to always be executed at the 
same location on the desktop.    See Window Initial Position below for 
instructions on setting the initial position.

Wrap This options causes SuperBars which are too large to fix within a window 
to be wrapped to multiple rows or columns.

Window Initial Position
Normal Execute the application where it was located the last time the Current 

Pos button was clicked.
Max Execute the application maximized (full screen).
Icon Execute the application as an icon.
Hidden Execute the application as a hidden window.    The program will run but 

will not occupy any desktop space.
Ok

Save all changes and close the dialog box.
Layout...

Edits the SuperBar    Clicking this button opens the SuperBar Layout dialog box.
Help

Displays this help information.



SuperBar Layout Dialog
This dialog is used to edit the layout of a SuperBar.    It allows setting the menu command, 
icon and caption for each button.
Dialog Box Options

Available Menu Commands
Lists all menu commands available to the application.    It only lists the menu commands 
currently assigned to the menu.    Many applications frequently change the layout of the
menu.    To select a menu command it must be available on the menu before opening 
this dialog box.    The list also consists of the following special purpose buttons:

<Space> A blank space the size of a button.    This can be used to group related 
buttons together on the SuperBar.

<HalfSpace> A blank space half the size of a button.
<Wrap> Forces the next button to be placed in a new row/column.
<Macro> A macro is assigned to the button.
<System> Commands beginning with <System> represent menu commands from 

the System menu. 
Current SuperBar Layout

Lists the menu commands currently attached to buttons on the SuperBar.    Select an 
entry from this list to allow editing, inserting or removing buttons on the SuperBar.    The 
list only contains the names of menu commands currently assigned to the menu.    If a 
button is assigned to a menu command not currently available, it will be displayed in the 
form:    [Unknown - ###] where ### is a unique identifier assigned to each menu 
command.

Caption
Selects the caption to be displayed on the button.    The caption must fit in this box to fit 
on the button.

Icon
Selects the icon to be displayed on the button.    Several general and special purpose 
icons are available.    Large character icons are also available if a predefined icon cannot 
be found.

Macro Options
The following options are used to assign a macro to a button.    They are only available if 
<Macro> is chosen from the Available Menu Commands list.
Macro File Indicates the name of the macro file to execute when the corresponding 

button is clicked. 
Normal Play back the macro at the same speed as it was recorded.
Fast Play back the macro as fast as possible.
Browse Brings up the Select Macro File dialog box to choose the desired macro 

file.
Add

Adds the selected menu command to the end of the SuperBar.
Insert



Inserts the selected menu command before the selected SuperBar button.
Change

Changes the selected SuperBar button to the selected menu command.
Remove

Removes the selected SuperBar button.
Ok

Accepts all changes and closes the dialog box.
Cancel

Ignores all changes and closes the dialog box.
Help

Displays this help information.



Record Macro
This dialog defines how a macro will be recorded.    The following setting may be selected.

Record Description
Everything Records all mouse movements, mouse clicks and key strokes.    This is 

recommended if none of the following methods works correctly.
Clicks & Drags Records all mouse clicks and key strokes.    Mouse movements are only 

recorded while one of the mouse buttons is down.    This is recommended 
for Paint type programs which require dragging and drawing.

Clicks Records only mouse clicks and key strokes.    This is recommended for use
when dialog boxes do not have an key stroke equivalents.

Ignore Mouse Records only key strokes.    This is recommended if all actions can be 
accomplished using key strokes.    This method also ensures compatibility 
if windows are resized or different video modes are used.

Relative to Description
Window All mouse actions are recorded relative to the active window.    If the 

window is moved, the macro should work correctly.    If the window is 
resized, the macro may not work correctly.

Screen All mouse actions are recorded relative to the screen.    If the window is 
moved or resized, the macro may not work correctly.



Save/Select Macro File Dialog
This dialog box is used to save or select a macro file.    It allows browsing through the 
available macro files and selecting a new or existing file.
Dialog Box Options

File Name
Shows the currently selected macro file and a list of available files.    To choose a file, 
enter a file name or click on a file from the list.

Directories
Shows the current directory path.    This is initially the directory where SuperBar is 
installed.    To change directories, double-click on a directory in the list.    It is 
recommended that all macros be placed in the same directory as SuperBar.

Drives
Shows the currently selected drive.    To change drives, click on the arrow and choose a 
new drive from the list.

OK
Accepts the file and closes the dialog box.

Cancel
Ignores the file and closes the dialog box.    This option can also be used to abort a macro
recording session.

Help
Displays this help information.



Preferences Dialog
This dialog box is used to select options for the SuperBar program.    It includes several 
options for customizing the SuperBar program.
Dialog Box Options

Hide Icon
Never Never hide icon.
After 10 Seconds Hide icon after 10 seconds.
Always Always hide icon.

Cache
Size Defines the size of the SuperBar button cache.    To improve drawing 

SuperBars, the images of recently used button icons are stored in 
memory.    This option sets the number of icons to store.    The value 
following this entry indicates the size of the cache in kilobytes.    The Hit 
and Miss values indicate the number of icons read from memory and 
read from disk respectively.    These counts are reset whenever the cache 
size is changed.    If Windows is running low on memory, the cache size 
can be lowered.    If the Miss count is large compared to the Hit count, 
the cache size can be raised to improve SuperBar drawing speed.

Double Click
Switch To Switches to the selected application when double clicking on the 

Application List.
Edit SuperBar Opens the SuperBar Properties dialog box for the selected application 

when double clicking on the Application List.
Close Terminates the selected application when double clicking on the 

Application List.
Hide Hides the selected application when double clicking on the Application 

List.
Ok

Accepts all changes and closes the dialog box.
Cancel

Ignores all changes and closes the dialog box.
Help

Displays this help information.



New Version Dialog
This dialog box is automatically displayed the first time SuperBar version 1.1 or higher is 
executed if a version 1.0 initialization file is found.    It explains how to update from version 
1.0 to the new version.
This update procedure is necessary because the version 1.0 initialization file has some 
incompatibilities which cannot be updated until each application is executed.
Dialog Box Options

Ok
Closes the dialog box.

Help
Displays this help information.



Update Dialog
This dialog box is automatically displayed the first time a SuperBar is edited under version 
1.1 or higher if a version 1.0 layout is found.    It presents the options for updating the 
version 1.0 layout to the new format.
Dialog Box Options

Update
Converts the version 1.0 layout to the new format and closes the dialog box.

Delete
Deletes the version 1.0 layout, creates an empty layout and closes the dialog box.

Help
Displays this help information.



Exit SuperBar Dialog Box
This dialog box is displayed whenever the Exit command is selected and the Quick Exit 
option is not selected in the Options menu.
Dialog Box Options

Ok
Exits SuperBar.

Cancel
Closes dialog box and returns to SuperBar.



Exit Windows Dialog Box
This dialog box is displayed whenever the Exit Windows command is selected and the 
Quick Exit Windows option is not selected in the Options menu.
Dialog Box Options

Ok
Exits Windows.

Cancel
Closes dialog box and returns to SuperBar.



Unable to Exit error
SuperBar is unable to exit because a SuperBar Properties dialog box is currently open.    All 
edit sessions must be closed before exiting SuperBar.



Invalid Registration Code error
The Registration Code is invalid.    Enter a valid Registration Code.



Can't Open Macro File error
SuperBar could not open the macro file attached to the button.    Enter the SuperBar Layout
dialog box for the application and correct the Macro File name.



Can't Create Macro File error
SuperBar could not create the macro file entered in the Save Macro File dialog box.    This 
error can occur if the file path is invalid or if the destination disk is full.    Record the macro 
again and save it to a valid file name.



Definitions

-A-
application

-B-
button

-C-
caption

-D-
desktop

-I-
icon

-M-
macro
menu command

-R-
Registration Code

-S-
SuperBar



Macro
The term macro refers to a series of mouse and keyboard events.    Macros are recorded by 
clicking the right button anywhere within a SuperBar and selecting Record Macro.    A 
macro is then assigned to a button using the SuperBar Properties dialog box.    Once this 
is complete, the macro is executed by clicking on the appropriate button on the SuperBar.



Menu Command
The term menu command refers to any item of an application's menu that sends a 
command to the application.    Any menu command can be assigned to a button.



Registration Code
The term Registration Code refers to the code which will be sent to registered users after 
sending in the registration fee.    The code must be typed into the Registration dialog box.    
The code can be typed in either upper or lower case.    Refer to the About dialog box or the 
other documentation included with this program for information on registering this 
program.



Application
The term application refers to a Microsoft Windows application which is compatible with 
SuperBar.    To be compatible with SuperBar, the application must have a standard Windows
Menu Bar.



Button
The term button refers to a single button on a SuperBar.    Each SuperBar can contain up to 
50 buttons.    Each button corresponds to an application's menu command.    Clicking on a 
button sends the corresponding menu command to the application.



Caption
The term caption refers to the caption text displayed on a button.    The caption is user 
configurable.    The caption is only displayed on certain button styles.



Desktop
The term desktop refers to the screen background for Windows.    Each Windows application
executes in a window on top of the desktop.



Icon
The term icon refers to the graphical picture displayed on a button.    The icon is selected 
from a list of predefined graphic and character icons.    The icon is only displayed on certain
button styles.



SuperBar
The term SuperBar refers either to the SuperBar program itself, or the actual bar located on
the application.    A SuperBar is a gray bar containing several buttons, each assigned to an 
application menu command.    Clicking on a button invokes the corresponding command.    
Double-clicking on the gray background of the bar allows editing of the SuperBar.


